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EMPLEO DE DATOS LIDAR Y GPS PARA LA ELABORACIÓN DE CARTOGRAFÍA EN 
ESTUDIOS DE INUNDABILIDAD EN CAUCES DE PEQUEÑO CAUDAL. 

RESUMEN 

Las nuevas tecnologías en teledetección, han posibilitado un avance en la obtención de los 
Modelos Digitales del Terreno empleados en la elaboración de cartografía de estudios de 
inundabilidad. Es el caso de los sensores laser aerotransportados conocido con el nombre de 
LIDAR (Light Detection and Ranging). Este trabajo realiza un estudio de inundabilidad de un 
tramo de cuenca de pequeño caudal en el municipio de Madrigal del Monte (Burgos), 
utilizando un MDT obtenido de los datos LIDAR del Centro Nacional de Información 
Geográfica y su comparación con el realizado utilizando un MDT obtenido por levantamiento 
topográfico mediante GPS. Se encontraron dificultades en la toma de datos GPS debido a la 
mala cobertura y los fallos del equipo por lo que el número de datos GPS resultó escaso, 
pero se ha podido constatar la necesidad de una adecuada familiarización de los 
procedimientos y algoritmos de cálculo del software empleado y se apuntan las ventajas e 
inconvenientes del uso  de uno u otro modelo. Del estudio hidráulico realizado con HEC-RAS, 
las mayores diferencias las encontramos en el cauce principal, donde la vegetación es muy 
abundante. Es necesario completar el trabajo ampliando la zona de estudio con la nueva 
toma de datos GPS que permita comprobar ambos modelos y discernir un método rápido 
que simplifique de manera coherente el proceso. 

Palabras clave: Teledetección, LIDAR, Modelo Digital del Terreno, estudios inundabilidad. 

1.- INTRODUCCIÓN Y OBJETIVOS 

La Directiva Europea 2007/60/CE sobre evaluación y gestión de riesgos de inundación [1] 
plantea la necesidad de detectar las zonas especialmente expuestas a riesgo de inundación 
sobre las que realizar estudios de peligrosidad y riesgo. Por tal motivo, el Ministerio de 
Agricultura, Alimentación y Medio Ambiente  dispone del Sistema Nacional de Cartografía de 
Zonas Inundables (SNCZI) al cual se puede acceder mediante el visor cartográfico de zonas 
inundables [2], enmarcado en el Real Decreto 903/2010 de evaluación y gestión de los 
riesgos de inundación [3] y en el Real Decreto 849/1986 por el que se aprueba el 
Reglamento del Dominio Público Hidráulico [4]. 

Actualmente El Ministerio de Agricultura, Alimentación y Medio Ambiente, está 
desarrollando numerosos estudios de delimitación del dominio público hidráulico y zonas 
inundables en los cauces de gran caudal en todas las Demarcaciones Hidrográficas de 
España, aunque como puede verse en el visor [2], existen gran cantidad de cauces 
pendientes de estudio, principalmente de pequeño caudal. 

Para desarrollar los trabajos de generación de cartografía de Dominio Público Hidráulico y de 
zonas inundables se han publicado diferentes guías metodológicas que definen los requisitos 



Máster en Tecnologías Avanzadas para el Desarrollo Agroforestal  
 
Empleo de datos LIDAR y GPS para la elaboración de cartografía en estudios de inundabilidad en cauces de pequeño caudal. 

Laurentino Cejudo Lara  2 
  

y procedimientos más adecuados para abarcar los diferentes aspectos de los trabajos a 
realizar [5], documentos de análisis de la información disponible de carácter general para la 
evaluación preliminar de riesgo de inundación como el de la Confederación Hidrográfica del 
Duero [6], así como memorias para la obtención de mapas de peligrosidad y riesgo de 
inundación en distintas demarcaciones hidrográficas [7]. 

La información de partida para los estudios del SNCZI necesita disponer de cartografía lo más 
actualizada posible y de calidad suficiente para que los resultados del estudio sean lo más 
realistas. A la hora de realizar el estudio hidrológico de la cuenca para calcular el área 
vertiente y otros parámetros hidrológicos, suele ser necesario disponer de un modelo digital 
del terreno (MDT) de la zona con una precisión suficiente para dichos cálculos, pero para la 
realización de estudios hidráulicos es necesario disponer de una cartografía de mayor 
precisión, por lo que una mala elección de la cartografía puede suponer errores en la 
modelización hidráulica. La guía metodológica para el desarrollo del sistema nacional de 
cartografía de zonas inundables [5], recomienda utilizar un MDT generado mediante 
tecnología LIDAR (Light Detection and Ranging). Los productos finales derivados del LIDAR, 
son el Modelo Digital del Terreno (MDT), el Modelo Digital de Superficie (MDS) y el Modelo 
Digital de Elevaciones (MDE),  esta distinción entre términos se encuentra bastante 
extendida en los usuarios de datos LIDAR, y responde a las diferentes altimetrías que 
representan uno y otro [8]. 

Dada la alta resolución de los datos LIDAR, estos se han utilizado en trabajos que los 
comparan con modelos digitales del terreno obtenidos a partir de otras fuentes y su 
idoneidad en la aplicación para en estudios de inundabilidad, así por ejemplo García, E. et al 
[9] consideran la cartografía LIDAR una solución válida e imprescindible, al ofrecer 
resultados más precisos que los obtenidos de las representaciones cartográficas 
tradicionales, Espejo, F. [10] en su trabajo fin de máster, estudia las diferentes cartografías 
obtenidas de vuelos LIDAR y de vuelos fotogramétricos y con diferentes resoluciones, para el 
análisis hidráulico en la rotura de balsas, donde justifica la adopción de cartografías base 
LIDAR de alta resolución para la implementación de los modelos de simulación hidráulica,  
Odón, O. [11] compara modelos digitales del terreno a partir de cartografías obtenidas del 
Plan Nacional de Ortofotografía Aérea (PNOA) y datos LIDAR para estudios hidrológicos, 
concluye que la utilización de los datos MDT del PNOA es perfectamente válida y no se 
justifica la ejecución de un LIDAR , puesto que el MDT LIDAR no aporta ninguna mejora 
sustancial, salvo que fuera de una precisión de 5 cm., Ferrer-Julià, M. et al. [12] realiza 
cartografía morfológica de zonas inundables a partir del análisis de datos LIDAR y la 
comparan con los datos obtenidos a partir de fotografías aéreas y ortofotomapas, donde los 
MDT a partir de datos LIDAR resultan ser idóneos, aunque considera que es necesario 
investigar y mejorar los algoritmos de filtrado de los datos LIDAR, dado que presentan 
problemas en las llanuras de inundación debido al ruido de la vegetación. 

Diversos estudios avalan el empleo de datos LIDAR tanto en España como en otros países, 
Magdaleno, F. et al. [13] Aplicaciones de la teledetección láser en la caracterización y gestión 
del medio fluvial, concluye con las ventajas del empleo de la tecnología LIDAR como la alta 
precisión y densidad de los datos y su toma en áreas inaccesibles, aunque también 
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encuentra alguna desventaja como el no poder delinear con precisión los límites de los 
cursos de agua  o la dificultad para cartografiar superficies cubiertas por vegetación muy 
densa, Gómez, A. [14] Sistema LIDAR para la confección de DTMs en reemplazo de 
fotogrametría convencional, donde se realiza una breve descripción del sistema LIDAR como 
herramienta para obtener un Modelo Digital del Terreno, y presenta el sistema como una 
opción precisa, rápida y económica en el sector de la topografía/cartografía, Aaron Cook et 
al. [15] Effect of topographic data, geometric configuration and modeling approach on flood 

inundation mapping, donde se demuestra que las áreas de inundación de los cauces 
estudiados presentan resultados más preciso al emplear mapas de mayor resolución 
obtenidos con LIDAR, G.R. Aggett et al. [16] Creating and coupling a high-resolution DTM 

with a 1-D hydraulic model in a GIS for scenario-based assessment of avulsion hazard in a 

gravel-bed river, donde utilizan datos LIDAR como principal fuente de información 
cartográfica que en su validación ofreció un error medio cuadrático notablemente bajo, o 
Christopher C. et al. [17] Use of terrestrial laser scanning data to drive decimetric resolution 

urban inundation models, sugiere que el uso de los datos de escaneo láser terrestre en lugar 
de, o en combinación con datos LIDAR aerotransportado influyen significativamente en el 
estudio de inundaciones. 

Pero todos ellos están encaminados al empleo de los datos en grandes extensiones, y no son 
comparados con cartografía más precisa, obtenida con métodos topográficos GPS (Global 
Positioning System) de precisión centimétrica. 

El objetivo de este Trabajo Fin de Máster pretende mostrar las diferencias que existen en los 
resultados, cuando se utilizan diferentes Modelos Digitales del Terreno obtenidos de datos 
procedentes de sensores LIDAR y técnicas GPS para el estudio de inundabilidad de una 
cuenca inferior a 50 Km2. En concreto de la cuenca del río Cubillo a su paso por el término 
Municipal de Madrigal del Monte, provincia de Burgos. 

2.- ÁREA DE ESTUDIO 

El área de estudio del presente trabajo es la cuenca del río Cubillo, Carabidas o de las 
Canteras a su paso por el Municipio de Madrigal del Monte en un tramo de unos 6 Km. y una 
superficie de cuenca de 46 km2, localizada en la zona Nordeste de la cuenca del río Duero, 
provincia de Burgos, (Figura 1). Dada la dificultad encontrada a la hora de la toma de datos 
GPS, al producirse una avería en el receptor, por otra parte la desazón que produjo la 
imposibilidad de obtener posicionamiento preciso por falta de cobertura de telefonía móvil 
con otro receptor, y dada la cercanía en las fechas de presentación del trabajo, se centró el 
estudio en los 1500 metros anteriores al núcleo urbano de Madrigal del Monte de los cuales 
se pudo obtener datos. 
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Figura 1 Localización del municipio de Madrigal del Monte (Burgos) y zona de estudio. 
Fuente: Elaboración propia a partir de información de la Infraestructura de Datos Espaciales de Castilla y 

León (IDECYL) 
 
 

3.- MATERIAL Y MÉTODOS 

3.1.- Datos LIDAR del Instituto Geográfico Nacional 

Los datos LIDAR utilizados se obtuvieron del centro de descargas de CNIG 
(http://centrodedescargas.cnig.es/CentroDescargas/catalogo.do#selectedSerie), la zona de 
estudio queda incluida dentro de los siguientes archivos de datos: 

PNOA_2010_Lote5_CYL-RIO_442-4666_ORT-CLA-COL.LAZ 

PNOA_2010_Lote5_CYL-RIO_444-4666_ORT-CLA-COL.LAZ 

PNOA_2010_Lote5_CYL-RIO_444-4668_ORT-CLA-COL.LAZ 

PNOA_2010_Lote5_CYL-RIO_446-4668_ORT-CLA-COL.LAZ 

PNOA_2010_Lote5_CYL-RIO_446-4670_ORT-CLA-COL.LAZ 

PNOA_2010_Lote5_CYL-RIO_448-4670_ORT-CLA-COL.LAZ 

 

Se trata de ficheros digitales con información altimétrica de la nube de puntos LIDAR, 
distribuidos en ficheros de 2x2 km de extensión. El formato de descarga es un archivo LAZ 
(formato de compresión de ficheros LAS, mediante la herramienta de descompresión 
LASTask Tools Visualizador [18] podemos visualizar de ficheros LAZ y LAS). Las nubes de 
puntos han sido capturadas mediante vuelos con sensor LIDAR con una densidad de 0,5 
puntos/m2, y posteriormente clasificadas de manera automática y coloreadas mediante RGB 
obtenido a partir de ortofotos del Plan Nacional de Ortofotografía Aérea (PNOA) con tamaño 
de pixel de 25 o 50cm. El sistema geodésico de referencia utilizado es el ETRS89 y proyección 
UTM en el huso correspondiente a cada fichero. Las alturas de cada punto son ortométricas. 
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El formato de archivo LAS es un formato de archivo público para el intercambio de datos 
procedentes de nubes de puntos tridimensionales entre los usuarios de datos. Aunque fue 
desarrollado principalmente para el intercambio de datos de nubes de puntos LIDAR, 
permite el intercambio de cualquier conjunto de elementos con coordenadas en 3 
dimensiones x, y, z. Este formato de archivo binario es una alternativa a los sistemas de 
propiedad o a los sistemas de intercambio de archivos ASCII genéricos utilizados por muchas 
empresas. El formato LAS mantiene la información específica a la naturaleza de los datos 
LIDAR sin ser demasiado complejo.  

Fue creado por la ASPRS (American Society for Photogrammetry and Remote Sensing, 
Sociedad Estadounidense de Fotogrametría y Teledetección).  Es un estándar de facto y 
como tal el software comercial dedicado a manejo de datos LIDAR puede leer dicho formato. 

Existe software gratuito que lee LAS, como por ejemplo Fugroviewer 
(http://www.fugroviewer.com/), así como algunos SIG gratuitos (gvSIG y QGIS, entre otros) 
pero con la ayuda de un software complementario.  
 
La especificación usada en los archivos LAS del IGN/CNIG es la 1.3.( 
http://www.asprs.org/Committee-General/LASer-LAS-File-Format-Exchange-Activities.html) 
 
El formato LAZ es un tipo de archivo binario obtenido de la compresión de los ficheros LAS 
mediante una librería de compresión desarrollada por Martin Isenburg para su herramienta 
LASzip. El uso del formato y de la herramienta LASTask Tools Visualizador, que pone a 
disposición de los usuarios el IGN y el CNIG, es libre, sin embargo la utilización de LASzip está 
sometida a ciertas restricciones. 

Otro software gratuito es FugroViewer, se puede descargar desde el enlace 
http://www.fugroviewer.com/request/default.asp y permite abrir y observar directamente 
los datos LIDAR desde el formato *.laz. 
 

3.2.- Datos topográficos tomados con GPS. 

El levantamiento topográfico se realizó mediante el sistema GPS utilizando el método 
cinemático en tiempo real RTK (Real Time Kinematic). Para este levantamiento se utilizaron 2 
receptores con equipo de radio-modem, un trípode rígido, un bastón y un flexómetro. 

Al producirse la avería de la unidad de control, se intentó con un solo receptor y 
correcciones en tiempo real obtenidas de la Red GNSS de Castilla y León que proporciona 
correcciones de código y fase para los sistemas de navegación GPS y GLONASS en tiempo 
real RTK a través de un caster NTRIP (Networked Transport of RTCM vía Internet Protocol). Es 
un servidor de Internet que, por una parte, gestiona los flujos de datos provenientes de las 
estaciones de referencia, y por la otra chequea los mensajes recibidos por los clientes NTRIP, 
controlando si los usuarios están autorizados, en cuyo caso, transfieren los flujos de datos 
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RTCM. Pero dada la falta de cobertura telefónica se tuvo que abandonar también este 
sistema, obteniendo finalmente un total de unos 250 puntos que permitieron modelizar 
1500 metros del cauce. 

3.3.- Otras fuentes de datos. 

• Modelo digital del terreno con paso de malla de 5 m. 

Para la delimitación de cuenca de estudio se utilizó el modelo digital del terreno MDT05, 
obtenido del CNIG compuesto por los siguientes ficheros: 

MDT05-0238-H30-LIDAR.asc 

MDT05-0276-H30-LIDAR.asc 

 

Se trata de un modelo digital del terreno con una matriz regular de cotas con puntos cada 5 
metros, representado en ETRS89 y proyección cartográfica UTM en el huso correspondiente. 
El origen del MDT05 es una interpolación (convolucion cúbica) a partir de la clase terreno de 
la nube de puntos LIDAR (densidad 0.5 puntos/m2) del Plan Nacional de Ortofotografía 
Aérea. 

• Ortofotos PNOA máxima actualidad. 

Las ortofotos más recientes disponibles del PNOA, con sistema geodésico de referencia 
ETRS89 y proyección UTM en su huso correspondiente. 

• Ortofotos Históricas del PNOA. 

Mosaicos de ortofotos del PNOA, desde el año 2004, con sistema geodésico de referencia 
ETRS89 y proyección UTM en su huso correspondiente. 

• Ortofotos del vuelo americano de 1956. 

Servicio WMS correspondiente a la Ortofotografía a partir de Vuelo Fotogramétrico nacional 
BN a escala 1:33.000 de 1956-57, realizado mediante colaboración del Ejército del Aire de 
España y la Fuerza Aérea de EEUU, conocido coloquialmente como vuelo americano del 56. 

• Cartografía topográfica de Castilla y León a escala 1/5000. 
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Cartografía topográfica básica del territorio de Castilla y León a escala 1:5.000. 
Infraestructura de Datos Espaciales de Castilla y León (IDECYL) 

Asimismo, se ha realizado un exhausto trabajo de campo en el que se han contrastado los 
resultados obtenidos mediante el resto de fuentes de datos y se ha recopilado una base de 
datos sobre infraestructuras transversales y longitudinales en el propio cauce, como son los 
puentes (Figura 2 y Figura 3). 

 

Figura 2. Foto del puente existente (aguas abajo) 

 

 

Figura 3. Croquis acotado de la sección del puente 

 

3.4.- Métodos 

El estudio se realizó en las siguientes etapas: 

A) Obtención de dos Modelos Digitales del Terreno (MDT). 

B) Delimitación de la cuenca receptora con la ayuda de herramientas GIS [19]. 



Máster en Tecnologías Avanzadas para el Desarrollo Agroforestal  
 
Empleo de datos LIDAR y GPS para la elaboración de cartografía en estudios de inundabilidad en cauces de pequeño caudal. 

Laurentino Cejudo Lara  8 
  

C) Estudio hidrológico de la cuenca y determinación de los caudales para distintos 
periodos de retorno. 

D) Estudio hidráulico con modelo unidimensional en régimen permanente, mediante 
HEC-RAS (USACE) [20] así como de la herramienta de pre-proceso y post-proceso 
HEC-GeoRAS (USACE) [21] para ArcGIS (ESRI) [19]. 

3.4.1.- Obtención de dos Modelos Digitales del Terreno (MDT). 

• MDT a partir de datos LIDAR: 

En primer lugar se procedió a la localización y descarga de los archivos correspondientes de 

la zona de estudio en la página web del Centro de Descargas del Centro Nacional de 

Información Geográfica (CNIG): http://centrodedescargas.cnig.es/CentroDescargas/inicio.do 

Los archivos descargados en formato LAZ se descomprimieron mediante el programa 
LASTask Tools facilitado por IGN.  
 
Inicialmente se realizó un filtrado mediante la aplicación groundfilter.exe de FUSION [22], 
que aplica el filtro de Kraus and Pfeifer con tamaño de celda 2.  
 
Posteriormente se generó el MDT con la aplicación GridSurfaceCreate.exe de FUSION y se 
comprobó los resultados obtenidos cargando el MDT creado con la opción BareEarth de 
FUSION y visualizándolo en 3D añadiendo la superficie creada con la opción Botón derecho 
Surfaces.  
 
Se pudo apreciar la gran pérdida de puntos LIDAR, lo que generó una gran indefinición del 
lecho del cauce, produciéndose numerosos cortes en el camino del agua (Figura 4). 
 
Por dicho motivo se abandonó este procedimiento ante la necesidad de introducir líneas de 
rotura y una depuración más precisa de los puntos, optándose por utilizar el programa 
TerraScan (Terrasolid) [23] aplicación MDL de Microstation [24]. 
 

 
Figura 4. MDT generado con FUSION 
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Mediante TerrScan se realizó un correcto filtrado de los datos para eliminar los puntos 

correspondientes a elementos distintos al terreno como vegetación, puentes, etc. y 

posteriormente obtener el MDT con el programa TerraModeler (Terrasolid) [25]. 

 

 

Figura 5. Umbrales de clasificación de suelo mediante la rutina Ground en TerraScan. 

 

Mediante la rutina Ground se clasifican los puntos de tierra por medio de la construcción 

iterativa de un modelo de superficie triangulada. 

La rutina construye un modelo inicial con los puntos bajos seleccionados. Los  triángulos de 

este modelo inicial estarán en su mayoría por debajo de la tierra con sólo los vértices en el 

suelo. La rutina comienza entonces moldear el modelo hacia arriba agregando 

iterativamente nuevos puntos láser a ella. Cada punto añadido hace que el modelo se sitúe 

más cerca del suelo. 

El ángulo de iteración es el ángulo máximo entre un punto, su proyección en el plano del 

triángulo y el vértice del triángulo más cercano. Con el parámetro de distancia se asegura de 

que la iteración no hace grandes saltos hacia arriba cuando los triángulos son grandes.  

Cuanto menor sea el ángulo de iteración, menos se producen los cambios en la nube de 
puntos (pequeñas ondulaciones en el terreno o señales en vegetación baja). Se usa un 
pequeño ángulo (cerca de 4,0) en terreno plano y un ángulo más grande (cerca de 10,0) en 
terreno montañoso. (Figura 5). No obstante, una vez aplicado el filtro, se procedió a la 
supervisión manual de los puntos con la ayuda de la herramienta “Draw Vertical Section“, y 
realizando numerosos perfiles transversales al terreno, se fueron clasificando manualmente 
los puntos mal clasificados (Figura 6). 
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Figura 6. Clasificación manual de puntos en TerraScan. 

 

 

En ocasiones, debido a la presencia de vegetación muy densa en el cauce del río y dado que 

el sistema LIDAR no la puede atravesar (ver Figura 7 y Figura 8), el modelo digital del terreno 

generado con tecnología LIDAR presenta algunos errores que cortan el camino del agua y 

dan problemas a la hora de realizar un estudio hidráulico. 

 

Figura 7. Foto de vegetación en cauce. 
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Figura 8. Situación de un perfil del cauce sobre ortofoto,  sobre  nube de puntos LIDAR y perfil seleccionado. 

 

Esto es un inconveniente generalizado, independientemente del software de procesado que 

se utilice, se solucionó, ayudado de las ortofotos disponibles, las correspondientes líneas de 

rotura que delimitan los taludes del cauce del río, interpolando las zonas indefinidas y 

realizando una triangulación adecuada (Ver Figura 10). Se procedió al dibujo manual de las 

líneas que aparentemente definen los taludes del cauce en 2D y posteriormente se situaron 

sobre el terreno mediante la herramienta de Terramodel “Drop Element On Surface”, 

además a las líneas inferiores del talud que conforma el cauce se les aplicó la herramienta 

Force Downstream Flow, que fuerza a la línea a llevar siempre una pendiente descendente, 

de esta forma se consiguió que las líneas de rotura se situaran siempre en las parte inferior 

del cauce y no sobre las zonas superiores creadas por los errores de corte del camino del 

agua. 

Para la realización de la modelización hidráulica correspondiente a la situación actual de la 

llanura de inundación, es decir, con una geometría del terreno alterada por las posibles 

modificaciones antrópicas existentes, se utilizará el MDTreal que consistirá en el modelo 

digital de superficies en el que se habrán eliminado los elementos correspondientes a la 

vegetación, se han corregido las profundidades de cauce, se han eliminado los puentes y se 

han incluido (y revisado) aquellos elementos antrópicos de larga duración, tales como 

edificios, motas, terraplenes, etc. lo cual se realizó manualmente con el programa 

TerraModeler. 
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El pulso del LIDAR, al rebotar sobre el tablero de los puentes, da como resultado que la cota 

del MDS en el punto sea la cota superior del tablero del puente, no la del cauce, por lo que 

será necesario restituir las cotas del cauce para que las modelizaciones posteriores sean 

correctas. El proceso necesario para la eliminación de los puentes es el siguiente: 

1. Identificación de las zonas que son candidatas a ser clasificados como puentes o 

pasos elevados. 

2. Comprobación de si realmente se trata de un puente paso elevado o, de lo 

contrario, se trata de un falso positivo. 

3. En el caso de tratarse de un puente, retoque manual de la parte del mismo que se 

quiere eliminar. 

4. Eliminación de las alturas de los puntos del MDS correspondientes a la zona que se 

haya seleccionado como puente. Si se interpolan directamente los puntos que se han 

borrado, habrá problemas con la calidad del MDT obtenido porque también se 

expandirán las alturas de la parte alta del puente hacia la zona eliminada. Para evitar 

este problema, será necesario definir líneas de rotura por medio de puntos que 

representen geométricamente la estructura. Estos puntos se seleccionan de forma 

visual, con la seguridad de que pertenecen al punto más bajo del puente. 

Posteriormente, sobre el MDS al que se le han eliminado los puntos del puente, se 

dibujaron las líneas de rotura. 

 

Figura 9. Localización de puente sobre ortofoto, modelo digital del terreno con puente y sección. 
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Figura 10. Ortofoto, modelo digital del terreno sin puente y con líneas de rotura, vista 3D de la sección. 

 

A partir del MDT obtenido y de las ortofotografías, se dibuja el eje del cauce y con la 

herramienta Draw Alignment Sections de Terrasolid se obtuvieron  perfiles transversales 

cada100 metros y de 50 metros de ancho a cada lado del cauce, se comprobó visualmente 

que no existían errores y se exportaron para su incorporaron a la medelización con HEC-RAS. 

 
Figura 11. Ejemplo de perfiles transversales LIDAR. 
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Por otra parte, se generó cartografía con las curvas de nivel del modelo del terreno para su 
incorporación en ArcGis y Hec-GeoRAS (Figura 12). 
 

 

Figura 12. Curvas de nivel del MDT obtenido a partir de los datos LIDAR del cauce. 

 

• MDT a partir de datos GPS: 

Para la obtención del levantamiento de detalle, la metodología de observación con GPS en 

tiempo real, es un método rápido, cómodo y capaz de dar la precisión requerida para el 

trabajo. El método de trabajo con GPS en tiempo real se compone de un GPS fijo de 

referencia y un GPS en movimiento. El receptor fijo lo situamos sobre un punto de la red 

básica, de coordenadas conocidas en el sistema de referencia local. Este vértice se denomina 

como vértice de referencia. 

La metodología en tiempo real se basa en el cálculo de ambigüedades en el mismo instante 

de la toma de datos. Tras poner en funcionamiento el receptor de referencia se ha de 

esperar a que éste resuelva las ambigüedades antes de proceder a la obtención de datos de 

los puntos del levantamiento. Si el número de satélites sobre el horizonte y su geometría es 

válido, el receptor de referencia fija ambigüedades en pocos minutos. Una vez realizada esta 

operación el cálculo de coordenadas de los demás puntos será instantáneo. La comunicación 

entre el receptor de referencia y los receptores móviles, es posible gracias al sistema de 

telecomunicaciones utilizado para la transmisión, con un alcance de 5 Km entre ambos 

receptores. Para evitar problemas de comunicación entre receptores puede elevarse la 

antena del receptor de referencia lo máximo posible. 
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Se estacionó el equipo de referencia (fijo), el receptor envía las correcciones (RTCM-RTIME-

RTCA) al equipo móvil a través de un sistema de telecomunicación operativo entre ambos 

receptores. Las coordenadas de los puntos, se obtienen en el sistema de referencia ETRS89 

[26]. La metodología RTK permite asociar una proyección y un sistema de referencia distinto, 

podemos obtener las coordenadas de los puntos directamente en la proyección UTM. 

También podrían obtenerse en cualquier otro sistema de referencia local con respecto al 

cual se haya realizado la georreferenciación. Las precisiones obtenidas en las coordenadas 

del levantamiento dependerán de varios factores (precisión de las coordenadas de la red, 

precisión de los equipos utilizados, errores accidentales cometidos, etc.). De esta forma, la 

precisión de los puntos del levantamiento puede llegar a ser del orden de 1-2 cm. El 

levantamiento se lleva a cabo por dos receptores, uno de referencia y otro móvil. Se realiza 

la toma de puntos con el receptor móvil, mientras que se va realizando los croquis de la 

zona, así como anotando el número de punto y su correspondiente descripción, quedando 

así definido cualquier tipo de elemento a representar. 

En los croquis se definen los accidentes del terreno como por ejemplo los taludes, para 

obtener un buen resultado en la realización MDT en gabinete. El levantamiento del cauce se 

efectuó mediante perfiles transversales donde la vegetación permitía la toma de datos GPS. 

 
Figura 13. Nube de puntos del cauce obtenidos con GPS, triangulación y perfiles transversales. 

 
Para obtener las cotas del terreno necesarias para realizar posteriormente el MDT de la 

zona, se toman una serie de puntos de relleno, dando una mayor densidad de puntos en las 

zonas donde la topografía del terreno es más variable. Al final de cada día los puntos 

observados en campo se importan al ordenador (Figura 13), observando la nube de puntos 

para asegurar el haber cubierto toda la zona a levantar y evitando que queden zonas sin el 

número de puntos adecuado para una buena edición posterior. 
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La captura de datos es el primer paso en el proceso de producción del MDT. Una vez listados 

todos los puntos tomados en campo, se exportan a formato ASCII, desde el programa de 

cálculo GPS. Con el fichero ASCII, se importan los datos al programa de cálculo topográfico, y 

desde él a formato DXF, para comenzar a trabajar desde el programa Microstation, en 

formato DGN, o DWG en AutoCAD [27]. De esta manera se obtiene la nube de puntos en un 

fichero de diseño 3D, con el cual poder realizar las operaciones necesarias para la obtención 

del MDT (Figura 14)  y obtener los perfiles transversales cada 100 metros coincidiendo en 

posición con los obtenidos en el modelo LIDAR. 

 
Figura 14. Curvas de nivel obtenidas de datos GPS. 

 

3.4.2.- Delimitación de la cuenca receptora con la ayuda de herramientas GIS 

Para delimitar una cuenca hidrográfica se procederá a determinar el punto de desagüe de la 

cuenca e ir dibujando el perímetro de acuerdo a la línea divisoria de aguas (previamente 

cargado un MDT), para ello emplearemos el programa ArcGIS [19]. 

En este proceso se empleó el Modelo digital del terreno con paso de malla de 5 m, con la 

misma distribución de hojas que el MTN50. Formato de archivo ASCII matriz ESRI (asc). 

Sistema geodésico de referencia ETRS89 y proyección UTM en el huso correspondiente a 

cada hoja, obtenido del centro de descargas del IGN.  

Una vez que se ha cargado el MDT, desde al ArcToolbox se utilizarán las siguientes 

herramientas siguiendo la siguiente secuencia: 

Eliminar imperfecciones (huecos y sumideros) del ráster con la herramienta Fill. 

ArcToolbox > Spatial Analyst Tools > Hydrology > Fill 
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Establecer la dirección del flujo hidrológico de la pendiente con la herramienta Flow 

Direction. 

ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Direcction 

Determinar la acumulación del flujo de las celdas que fluyen hacia cada celda descendiendo 

sobre la pendiente por medio de la herramienta Flow Accumulation. 

ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Accumulation 

Construir automáticamente la red hídrica por medio de un condicional (esto depende del 

tamaño del ráster) en  “Expression” usaremos la expresión value > 400, este valor depende 

del tamaño del pixel y del ráster, mientras más grande sea la microcuenca se debe usar un 

valor mayor, otra opción es usar Raster Calculator con la herramienta“Con”, es decir el 

condicional permite clasificar las celdas con acumulación de flujo superior a un umbral 

especificado por el usuario, por ejemplo al ingresar un valor bajo como resultado mostrará 

afluentes pequeños de la red de drenaje, pero mientras más alto sea el valor se obtendrá la 

red de drenaje de mayor tamaño. 

ArcToolbox > Spatial Analyst > Conditional > Con 

Como siguiente paso generar un vector entre el resultado de los rásters de la acumulación 

de flujo y el condicional con, con ayuda de la herramienta Stream to Feature. 

ArcToolbox > Spatial Analyst Tools > Hydrology > Stream to Feature 

El siguiente paso determinaremos el punto de desagüe de la microcuenca, esto se puede 

hacer creando un shapefile tipo punto, luego interpolarlo con un modelo de elevación digital 

(TIN o DEM) para obtener sus coordenadas en tres dimensiones. 

ArcToolbox > 3D Analyst Tools > Functional Surface > Interpolate Shape 

Para culminar con la herramienta Watershed usando el ráster creado con Flow Direction y el 

punto de desagüe. 

ArcToolbox > Spatial Analyst Tools > Hydrology > Watershed 

Finalmente para obtener el polígono de la microcuenca convertimos el ráster a shapefile tipo 

polígono (Figura 15). 

ArcToolbox > Conversion Tools > From Raster > Raster to Polygon 
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Figura 15. Cuenca receptora del cauce 

 

3.4.3.- Estudio hidrológico de la cuenca y determinación de los caudales para distintos 

periodos de retorno. 

La determinación de los caudales de cálculo a emplear se realizó según las recomendaciones 
de la guía Metodológica para el desarrollo del sistema nacional de cartografía de zonas 
inundables [5], para determinar los caudales de cálculo se utilizó el mapa de caudales 
máximos (CDEX, 2009) [28]  desarrollado por el Centro de Estudios y Experimentación de 
Obras Públicas (CEDEX) para la Dirección General del Agua (DGA) del Ministerio de Medio 
Ambiente y Medio Rural y Marino (MARM), que dispone de la aplicación CAUMAX  en la que 
es posible consultar los caudales máximos instantáneos en régimen natural asociados a 
distintos periodos de retorno para los cauces con una cuenca superior a 50 km2 y calcular 
estos caudales mediante el método racional [29] modificado para cauces con cuencas 
inferiores a 50 km2, donde el caudal viene dado por la expresión: 

 
Siendo: 

Q: Caudal de máxima avenida, en m³/s. 

I (mm/h): Intensidad de la lluvia máxima, expresada en mm/h, en un tiempo de duración 
igual al de concentración de la cuenca. 

(1) 
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A (km²): Superficie de la cuenca en km². 

C: Coeficiente de escorrentía superficial de la cuenca, correspondiente a la precipitación Ic. 

K: Coeficiente de uniformidad, dado por la expresión: 

 
donde Tc, es el tiempo de concentración de la cuenca que se obtiene mediante: 

 
donde: 

L = Longitud en km 

J = Pendiente (m/m) 

El coeficiente de escorrentía define la proporción de la componente superficial de la 
precipitación. Depende en consecuencia, de la capacidad de infiltración del suelo, de la 
cubierta vegetal del mismo y de la pendiente de la cuenca. La expresión para su cálculo es: 

 
donde: 

Pd = precipitación diaria correspondiente al periodo de retorno considerado en mm 

Pd*= precipitación diaria modificada correspondiente al periodo de retorno considerado en 
mm, corregida con el coeficiente KA (para tener en cuenta la no simultaneidad de las lluvias 
máximas de un mismo período de retorno en toda la superficie) en función del tamaño de la 
cuenca: 

(2) 

(3) 

(4) 
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KA = 1 Para A<1, con A, superficie de la cuenca en km² 

Po = umbral de escorrentía a partir del cual se inicia la misma en mm 

C = coeficiente de escorrentía 

La estimación de Po se realiza en función de los valores de la Tabla 2.1 que aparece en la 
Instrucción 5.2-IC [30]. Por lo tanto es necesario conocer para cada cuenca: 

- grupo de suelo 

- usos de tierra 

- características hidrológicas 

- pendiente 

Po, es un número entero adimensional que varía entre 0 y 100, por lo que es indistinto 
utilizar uno u otro de estos dos conceptos, se realizará en función del umbral de escorrentía 
Po al resultar éste más intuitivo que el número de curva. Los valores del umbral de 
escorrentía se recogen en la Tabla 1 de la Instrucción 5.2-IC que se adjunta a continuación. 

 

 

 

 

 

 

 

 

(5) 
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Tabla 1. Estimación inicial del umbral de escorrentía Po (mm) 
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Deben considerarse además, las condiciones de humedad previas del suelo esperables en la 
cuenca en la época del año en que habitualmente se presenta la crecida. Para ello, se 
modificará el umbral de escorrentía con el coeficiente corrector que resulte de la aplicación 
de la figura 2.5 de la Instrucción 5.2.IC Figura 16), si bien, afectada de un coeficiente 
reductor de 0,75 (dado que se consideran los valores de la figura 2.5 sobrevalorados). 

 

 
Figura 16. Figura 2.5 de la Instrucción de Carreteras 5.2 IC. 
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En cuanto a la intensidad media de precipitación se empleará la expresión: 

 

 
 
Siendo: 

It: Intensidad de lluvia media en el intervalo de duración t (igual al tc) para un período de 
retorno dado, en mm 

Id: Intensidad de la lluvia diaria para el mismo período de retorno 

tc: Tiempo de concentración (duración del aguacero) 

I1/Id Relación entre la intensidad de lluvia horaria y diaria (según Figura 17de la Instrucción 
5.2-IC), independiente del período de retorno. 

Id* Precipitación máxima diaria modificada retorno (en mm), para el mismo período de 
retorno. Se obtiene como Pd*/24. 

(6) 
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Figura 17. Mapa de Isolíneas I1/Id de la 5.2 IC. 

 

De acuerdo con la metodología propuesta, y con los datos obtenidos de la aplicación 
CAUMAX para el lugar de estudio, se obtuvieron los caudales de la cuenca para los periodos 
de retorno de 2, 5, 10, 25, 100 y 500 años (Tabla 2 y Tabla 3). 

 
Tabla 2. Caudales de cálculo para el punto más alejado de la cuenca de estudio y distintos periodos de 

retorno. 
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Tabla 3. Caudales de cálculo para el punto de entrada del tramo de estudio y distintos periodos de retorno. 

 

3.4.4.-Estudio hidráulico con modelo unidimensional en régimen permanente. 

Para el estudio hidráulico se ha empleado el modelo unidimensional, que se basa en el 
cálculo de la cota del nivel del agua en las secciones de cálculo, resolviendo las ecuaciones 
de Saint-Venant en una sola dimensión. Los modelos de una dimensión han sido 
ampliamente estudiados, pueden consultarse [31, 32] entre muchos otros trabajos. Las 
secciones de cálculo se colocan perpendiculares al flujo, y se supone que la lámina de agua 
está a la misma cota a lo largo de toda la sección. 
 
Se emplea un modelo de régimen permanente, dado que las características geomorfológicas 
e hidrológicas lo permiten, además se simplifica el proceso de cálculo. 
 
Para realizar la modelización se empleó el modelo HEC-RAS (USACE), por ser uno de los 
modelos más utilizados y de libre distribución, así como la herramienta de preproceso y post 
proceso HEC-GeoRas (USACE) para ArcGIS. 
 
La metodología del proceso es: 
 

1. Un “preproceso” (trabajo previo con ArcView y HEC_GeoRAS), para generar un 
archivo de importación para HEC-RAS y que contiene información geométrica de las 
secciones transversales o su introducción manual. 
 

La geometría del cauce se obtiene de los dos distintos modelos digitales del terreno, 
incorporando los datos del eje del cauce georreferenciados, así como las secciones 
transversales cada 100, posteriormente se interpolan secciones cada 25 metros (Figura 18). 
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Figura 18. Modelizado con HEC-RAS 

 
La cartografía a utilizar procede del MDT obtenido a partir de observaciones LIDAR y de los 
datos GPS, en formato vectorial TIN (Trianguled Irregular Network) (Figura 19).  
 

 

 
Figura 19. Representación de los TIN obtenidos. Izda. datos LIDAR, Dcha. Datos GPS. 

 
  

2. La modelización del flujo con HEC_RAS que a su vez genera un archivo de exportación 
para ArcView. 

 
Introducir las secciones (Figura 20) con puentes y/o culverts (Geometric Data – Brdg/Culv). 
Definir áreas inefectivas (Flow Areas), estructuras en línea (Inline Structure) o laterales 
(Lateral Structure) y obstrucciones al flujo (Obstructed Areas).  
Introducir los datos hidráulicos con la herramienta Edit/Steady Flow Data. 
Definir las condiciones de contorno (Reach Boundary Conditions). 
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Definir los caudales de cada perfil así como los valores del coeficiente de Manning obtenidos 
de la tabla 3-1 el manual de HEC-RAS [20], dadas las características del cauce se optó por 
asignar un coeficiente de Manning de 0.035 para el cauce principal y de 0.03 para el resto. 
Crear un plan y ejecutar una simulación con la herramienta Run/Steady Flow Analysis. 
 

 
Figura 20. Introducción de datos de las secciones en HEC-RAS 

 
 
Finalmente se comprobaron los resultados visualizando las secciones transversales, los 
perfiles de las láminas de agua, gráficos de varios parámetros, curvas de caudal-calado de 
cada perfil etc. (Figura 21). 
 

 
Figura 21. Resultados de la modelización en HEC-RAS. 
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3. Un “postproceso” mediante HEC-GeoRAS, que genera los resultados finales: 
superficies de inundación para cada periodo de retorno, grids de profundidad… 
(Figura 22). 

 

 
Figura 22. Ejemplo de postproceso con lámina de inundación generado con HEC-GeoRAS sobre ortofoto. 

 

4.- RESULTADOS Y DISCUSIÓN 

Se presentan los resultados obtenidos teniendo en cuenta que debido a los problemas ya 
comentados, a la hora de tomar datos GPS en campo, no se ha podido modelizar todo el 
tramo del río a su paso por el municipio, por lo que el estudio se realizó en 1500 metros, por 
otra parte y debido a ese mismo problema y dado que no se dispone de tiempo para la 
nueva toma de datos, no se cubre la totalidad del ancho necesario para que las láminas de 
agua no superen el ancho del modelizado en alguno de los periodos de retorno 
considerados. 
 

Con las diferentes simulaciones realizadas se han podido extraer diferentes resultados: 
 

• Láminas de inundación para distintos periodos de retorno. 

• Anchos de lámina de agua en cada perfil. 

• Mapas de calados. 

• Mapas de velocidades 
 

4.1.- Láminas de inundación. 

Mediante el postproceso con HEC-GeoRAs se obtuvieron los diferentes polígonos de la 

lámina de inundación, se presentan para periodos de retorno de 2, 5, 10, 25, 100 y 500 años, 

cuyas áreas se indican en la Tabla 1. Se adjuntan los mapas generados con ArcGis en el 

Anexo. 
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Tabla 4. Comparativa entre superficies de láminas de inundación entre ambos modelos. 

SUPERFICIE TOTAL DE LA LÁMINA DE AGUA (m2) 

Periodo de Retorno (años) MDT-LIDAR MDT-GPS Diferencia Porcentaje 

2 16066.00 10001.00 6065.00 37.75 

5 43678.00 23241.00 20437.00 46.79 

10 61442.43 58249.91 3192.52 5.20 

25 68805.91 75165.55 -6359.64 -9.24 

100 83069.65 77910.67 5158.98 6.21 

500 86677.64 86752.22 -74.58 -0.09 

 

Los resultados muestran diferencias importantes en periodos de retorno pequeños, debido a 

que en el modelo obtenido por GPS el caudal circula por el cauce principal, mientras que en 

modelo LIDAR se producen desbordamientos, seguramente debido a que los datos LIDAR no 

permiten definirle con exactitud, dada la gran cantidad de vegetación existente. Para 

periodos altos las diferencias disminuyen notablemente, aunque este hecho también puede 

deberse a la falta de datos del terreno de las llanuras de inundación. 

Por otra parte, al estudiar geométricamente las diferentes superficies podemos ver el 

porcentaje de coincidencia en el espacio indicado en  la Tabla 5. 

Tabla 5. Superficies coincidentes (m2) de las láminas de inundación. 

Periodo de Retorno 
(años) 

Superficie 
común 

Porcentaje 
común 

2 8851.00 55.09 

5 19852.00 45.45 

10 45930.70 74.75 

25 58716.32 78.12 

100 67922.46 81.77 

500 77434.88 89.26 

  

Al obtener los polígonos de intersección entre las distintas láminas de inundación (ver Figura 

23 y Figura 24), se puede apreciar que en periodos de retorno pequeños los datos LIDAR no 

producen resultados correctos al producirse desbordamientos del cauce principal, a medida 

que los desbordamientos del cauce se producen también en el modelo GPS, las coincidencias 

son mayores, lo que viene confirmando que el modelo LIDAR no se ajusta con caudales 

pequeños que deben circular confinados en el cauce principal, se explica por la mala 

definición de este debido a la alta densidad de vegetación en el cauce, mientras que en las 

llanuras de inundación se obtienen un mayor número de puntos pertenecientes al terreno 

donde se consigue un MDT más definido. 
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Figura 23. Comparación entre láminas de inundación, (a) periodo de retorno de 2 años, (b) periodo de 
retorno de 5 años, (c) periodo de retorno de 10 años, (d) periodo de retorno de 25 años. 

 

 
Figura 24. Comparación entre láminas de inundación, (a) periodo de retorno de 100 años, (b) periodo de 

retorno de 500 años 

 
 

 

(a) (b) 

(c) (d) 

(a) (b) 
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4.2.- Anchos de lámina de agua en cada perfil. 

Se tomaron un total de 15 perfiles del terreno para la simulación con HEC-RAS, de los cuales 

se pueden obtener las anchuras de la lámina de inundación, en la Tabla 6 se indican las 

diferencias de anchos de cada perfil encontradas entre los dos modelos considerados y para 

los distintos periodos de retorno estudiados. 

Tabla 6. Diferencias en los anchos de las secciones HEC-RAS. 

 DIFERENCIAS MODELO GPS - MODELO LIDAR 

SECCIÓN Q2 Q5 Q10 Q25 Q100 Q500 

37 -0.79 -3.87 -10.51 -10.51 -0.01 -3.91 

36 0.31 3.88 -28.88 8.93 -36.24 -36.22 

35 2.82 -27.06 -27.7 -33.03 48.94 -42.63 

34 -27.23 -38.42 4.98 -45.18 -47.91 1.32 

33 -0.04 -0.05 -46.27 4.95 12.08 16.84 

32 -1.45 -4.43 3.17 -50.48 1.27 1.31 

31 -1.97 -24.11 45.17 36.85 33.91 -10.64 

30 0.51 0.06 41.97 -4.9 -5.49 -5.49 

29 -6.25 -49.05 -48.51 -1.24 -2.6 -2.97 

28 -0.37 22.8 9.15 15.19 14.99 10.6 

27 -1.57 12.48 -12.47 14.95 -0.96 -7.15 

26 -3.68 5.63 -5.4 -6 -4.48 -4.74 

25 -15 -20.53 11.52 10.97 19.22 -9.89 

24 -2.63 -10.07 2.29 -14.16 -12.42 -8.09 

23 0.62 -17.08 -17.37 -17.29 -17.13 24.61 

PROMEDIO -3.78 -9.99 -5.26 -6.06 0.21 -5.14 

DESV. ESTÁNDAR 7.70 19.40 27.17 23.66 24.50 17.20 

 

Si observamos las diferencias atendiendo a un mismo periodo de retorno vemos valores 

grandes en alguna de las secciones, esto se debe a que en dichas secciones la vegetación es 

más densa, y como consecuencia la definición del terreno por los datos LIDAR es 

insuficiente. No obstante los promedios no son excesivamente altos, para todos los periodos 

de retorno las anchuras del modelo LIDAR son en general mayores, y donde menor 

desviación encontramos es para el periodo de retorno de dos años, dado que se producen 

menos desbordamientos. 

4.3.- Mapas de calados. 

Un dato importante a la hora de evaluar riesgos de inundación y la zona de flujo preferente 

(ZFP) es el calado junto con las velocidades máximas. Se define la ZFP en el artículo 9.2 del 

Reglamento del Dominio Público Hidráulico [4], y se considera que se pueden producir 

graves daños sobre las personas y los bienes si se verifica que el calado es superior a 1 

metro, la velocidad mayor de 1 m/s o el producto de ambas variables mayor a 0,5 m2/s para 

la avenida de 100 años de periodo de retorno, por lo que se compara el calado de los 
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modelos únicamente para este periodo de retorno y teniendo en cuenta que las superficies 

no son iguales. El resto de mapas de calados pueden verse en el Anexo I. 

 

Figura 25. Ráster diferencia de calados entre modelo GPS y modelo LIDAR para el periodo de retorno de 100 
años. 

Como puede verse en la Figura 25, se obtienen unas diferencias muy elevadas en las zonas 

cercanas al cauce principal (color rojo), donde el calado del modelo GPS es mucho mayor, 

claramente se explica por los mismos motivos que en los apartados anteriores, la masa 

arbórea del cauce no permite realizar una buena definición del terreno con datos LIDAR, 

dejando secciones más estrechas que las obtenidas por GPS, el modelo LIDAR genera taludes 

más inclinados del cauce, por lo que las diferencias de calado son en realidad por las propias 

diferencias del terreno modelizado. 

En cambio, en las zonas exteriores al cauce principal, la diferencia de calados es pequeña 

(color verde) y mayores valores de calado para el modelo LIDAR (color azul), donde la 

definición de este modelo es mucho mejor. 
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4.4.- Mapas de velocidades. 

Al igual que en el apartado anterior, se comparan los mapas de velocidades para el periodo 

de retorno de 100 años, por ser este el considerado para la determinación de las zonas de 

flujo preferente. 

 

Figura 26. Ráster diferencia de velocidades entre modelo GPS y modelo LIDAR para el periodo de retorno de 
100 años. 

 

En la Figura 26 podemos apreciar que encontramos grandes diferencias de velocidad en 

zonas puntuales del cauce principal donde en el modelo GPS son mayores (color rojo), 

siendo muy parecidas en el resto de la llanura de inundación, encontramos mayores 

velocidades del modelo LIDAR (color azul) en los extremos de la lámina, aunque también 

existen dos zonas junto al cauce principal. En cualquier caso la mayor parte de la lámina 

presenta poca diferencia y siempre a favor del modelo GPS en el cauce principal, lo cual se 

corresponde con las comparaciones realizadas en los anteriores apartados.  
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5.- CONCLUSIONES 

EL trabajo queda inconcluso, no por la longitud pequeña del cauce, sino por la necesaria 

familiarización tanto en procedimientos como en algoritmos de cálculo del número elevado 

de Software necesario y por fallos de los equipos utilizados, lo que hizo necesaria una 

dedicación de tiempo excesiva para los plazos fijados. 

El uso de datos LIDAR presenta ventajas respecto al empleo de datos GPS, permite acceder a 

mayor área de estudio así como un mayor volumen de datos, además de una disminución 

importante de salidas al campo. Si bien presenta dificultades a la hora de obtener puntos en 

zonas de vegetación fundamentalmente en el cauce principal, mejorable si el momento de 

toma de datos LIDAR coincidiese con el de menor densidad de hojas, por lo que se precisa de 

un mayor ensayo en los métodos de filtrado de puntos. 

Los datos GPS son de mayor precisión, pero presenta dificultades, requiere tomar datos del 

área de estudio suficientemente ancha de las llanuras de inundación, y existen numerosas 

zonas de escasa cobertura por vegetación.  

En la modelización realizada, para periodos de retorno pequeños encontremos 

desbordamientos del cauce principal injustificados, tal como se puede apreciar con el 

modelo obtenido por GPS más exacto. 

Por otra parte, para los periodos de retorno altos (25 o más años) los modelos parecen 

comportarse de igual forma, dando llanuras de inundación parecidas, aunque esto deberá 

ser comprobado cuando se disponga de suficiente extensión de datos GPS. 

Se ha podido comprobar que el calado y la velocidad para un periodo de retorno de 100 

años, el modelo con cartografía LIDAR presenta grandes diferencias respecto a la cartografía 

GPS, fundamentalmente en las zonas del cauce principal. 

Es necesario continuar el trabajo de investigación, ampliando la zona de estudio con la 

nueva toma de datos GPS que permita comprobar ambos modelos y discernir un método 

rápido que simplifique de manera coherente el proceso. 
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